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ABSTRACT

Computer Aided Electrical Drawing (AutoCAD)

The purpose of this e-book is to provide the knowledge and
experience needed by students in drawing objects using
AutoCAD software. Students can learn in brief the use of icons
found in AutoCAD 2019. There are 3 topics that need to be given
attention to give a clear picture of Autocad, are Introduction,
Basic Drawing Tool and Display Control. In this e-book will
provide valuable information with support diagrams to help
students more understanding in conducting their practical
laboratories. Finally, it is hoped that this book can benefit all who
want to deepen the knowledge of Computer Aided Design.
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CHAPTER 1
INTRODUCTION TO AUTOCAD

1.1 Introduction

Computer-aided design (CAD) is computers aided
drafting and design software from Autodest Inc. It
to aid in the creation, modification, analysis, or
optimization of a design.
CAD software is used:
e Toincrease the productivity of the designer,
. Improve the quality of design,
o Improve communications through
documentation,
e Tocreate adatabase for manufacturing.

1.2 Advantages of autocad over conventional
technical drawing

s+ Improves the productivity, efficiency, and
accuracy of drawings

+s* Enables drawings to be created, checked, and
edited quickly

t* Improves the quality of products

+*s* Retains uniformity in reproduction

+*+* Minimizes storage space



https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/Design

1.3 Concept of Computer Aided Design (CAD)

Computer-aided design (CAD) is the use of
computers (or workstations) to aid in the creation,
modification, analysis, or optimization of a design.
CAD software is used :Designs made through CAD
software are helpful in protecting products and
iInventions when used in patent applications. CAD
output is often in the form of electronic files for
print, machining, or other manufacturing operations.
The term CADD (for computer aided design and
drafting) is also used.

1.4 Hardware Computer in Autocad Software

g

*¢* Computer/ Laptop
*¢* Keyboard
** Mouse

¢

L R 4

L R 4

g

** Printer/Plotter

¢
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1.5 Autocad 2019 icon Menu
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1.6 Create A New Drawing

1. Click Start Drawing - Click New

Hew
Home . rtric View Manage Output Add-ins  Collabora
Creates a blank drawing file

o -

[ QNEW
Press F1 for mere help

Draw +

. DPRACTICAL WORK 1

.  PW2 SAFRI

: Drawingl1.dwg LABE 1 16DEE20F1032 NEW
1

Start Drawing
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A Select template >

Look in: | Template ~.-v| &= q ﬁ - 4 q Views + Tools

Marme Preview
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File name: ~ || Qpen E

Files of type:  Drawing Template {* dwt) > Cancel

Autodesk AutoCAD 2019 - EDUCATIONAL VERSION  DrawingZ dwg

[=1Tep][20 Wirefram e]

TOP

_;: command: <Grid off>

@ - A K A v £ Diafting & Annotation ~

A new drawing is created for you based on the drawing template
selected.




2. Set the LIMITS in AutoCAD

There are two methods of doing this.
1. Type Limits at the command prompt. OR
2. Click FORMAT LIMITS from the Pull-down menu (Autocad

Classic).

The sample of paper size

(0,420) 594mm (594.420)
‘- -
(0,297) 420mm (4p0297) A2
=== ___!
Upper right :
i corner
(0.210) 297mm (297.210)
297mm
420mm
Ad 210mm
(0,0)
&
:- (297.0) (420,0) (594.0)

S Lower left corner

Example
For A2 size

Command: limits

Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0,0.0>: 0.0
Specify upper right corner <0.0,0.0>: 594,420

For A3 size

Command: limits

Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0,0.0>: 0.0
Specify upper right corner <0.0,0.0>: 420,297

For A4 size

Command: limits

Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0,0.0>: 0.0
Specify upper right corner <0.0,0.0>: 297,210




1.7 Saving A Drawing

ol B EI :.: D-_-, i] IEI *- - =| £ Drafting & Annotation
File Edit View Insert Format Tools Draw Dimension Modify

Mew... Ctri+M

Mew Sheet Set...
Open... Ctrl+ 0O

Open Sheet Set...
Load Markup Set...
Close

Partial Load

Import...
Attach...

E Save Ctrl+5S
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B Export...
EI'_-| Export Layout to Model...

A Save Drawing As ot
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File name: Drawing . dwg e Save

Filles of type: | ptoCAD 2007/LT2007 Drawing (. dwa) > Cancel

Saving in AutoCAD File Format

1.0On [File] menu, click [Export] - [Export to DXF File] / [Export
to DWG File].

2.[Export] dialog box will be displayed.

3.Select a saving location.

4.Enter afile name in [File Name] box.

5.Click [Save] button.

6.The drawing created in RootPro CAD will be saved as an
AutoCAD drawing file







CHAPTER 2
AUTOCAD BASIC DRAWING

2.1 Basic Drawing Tools

In AutoCAD before drawing, we need familiar with
the user interface of AutoCAD and the basic tools. In
this chapter, we will learn how to make simple
drawings using the basic draw and modify tools
available in AutoCAD. Using these tools, you will be

able to make and modify the simplest of drawings in
AutoCAD.

2.1.1 Line
This is the most basic of the draw tools and one of

the most frequently used ones in the drawing
workflow. Line are creates straight line in drawing

area. With Line, can build object. Have 2 way use
line in AutoCAd

I. Line Command in ribbon panel

l WEEFEEL S«

Home Insert Annotate Parametric Vi

e B O %
- 9% M
j—l = |_|—.'- ] A

Draw Madify

Line ‘*olvline Circle Arc
¥

Figure 2.1 : Line

Command: L
LINE

= LINE specify first point:

Figure 2.2 : Line Command




2.1.2 Arc

An Arc is a segment of a quarter circle. It
combinations of center, endpoint, startpoint, radius,
angle, chord length, and direction values.

Limne Holyline Circle

Diraw -

Figure 2.3 : Arc

Select the Arc tool from the Draw panel in the
Home tab. You can also use its command: ARC.

Line Polyline Circle | Arc

. e

I._.II I

LDEAWING RECO...

o

Details - 2

File name: 16DEET19F2997 - -
I ; ; start, Center, Length

Start, End, Angle
Start, End, Direction
Start, End, Radius
Center, Start, End
Center, Start, Angle

Center, Start, Length

Figure 2.4 : Type of Arc




i. Point

Draws an arc using three specified points on the arc's
ﬁtﬂ- circumference. The first point is the start point (1).

o T I [ | E % . - . . Fr . ® - =L F_._.._ . __  mgE
|_|,.—' ,r' T | ¥ —l.l_II g = | T IR e o T L o oy g Y o
L] | . ¥ 1 '} LBL] o . ia [ k] LN L 1L =TT D i =
HELITY L econd |_,._]..I.I_.|.__,_*,|_ 153 |_,._.-..I.I_.._.-.I.I he circumrerence of the

Figure 2.5 : Point

li. Start, Center, End

It creates an arc using the start point, center point
and endpoint.

Figure 2.6 : Start, Center, End

iii. Start, Center, Angle

It creates an arc using the start point, center point
and included angle.

Specify the start point of the arc.

Figure 2.7 : Start, Center, Angle




iv. Start, Center, Length
It creates an arc using the start point, center point

and length of chord.

Specify the start point of the arc
-;nﬂ"‘@ﬂnﬂL

~ Starts by specifying the center of the circle of which the arc is a
part.

Figure 2.8 : Start, Center, Length

v. Start, End, Angle

It creates an arc using start point, end point and
included angle.

Qa“# Specify the start point of the arc (1)

-

Starts by specifying the center of the circle of which the arc is a

 End H part. (2)

Figure 2.9 : Start, End, Angle

vi. Start, End, Direction

It creates an arc using the start point, end point, and
starting direction.

‘dﬁgg Specify the start point of the arc (1)
gl,,.»."- E

Starts by specifying the center of the circle of which the arcis a

- part. (2)

Figure 2.10: Start, End, Direction




vii. Start, End, Radius
It creates an arc using the start point, center point

and length of chord.

#‘q, Specify the start point of the arc
o

Harlsl:r specifying the center of the circle of which the arcis a

Figure 2.11 : Start, End, Radius
viii. Center, Start, End

It creates an arc using start point, end point and
included angle.

Specifies the center of the circle of which the arc is a part. (1).

mm” Specify start point of arc.. (2)

Figure 2.12 : Center, Start, End

ix. Center, Start, Angle

It creates an arc using the start point, end point, and
starting direction.

Specifies the center of the circle of which the arc is a part. (1).

o

'ﬂ!l'-lll'ﬂht Specify start point of arc. (2)

Figure 2.13 : Center, Start, Angle




X. Center, Start, Length
It creates an arc using the center, start point and

length of chord.

Specifies the center of the circle of which the arc is a part. (1).

o™

Startpoint  SPECy start point of arc. 2]

Figure 2.14 : Center, Start, Length

2.1.3 Circle

Select the Circle command from the Draw panel in
the Home tab, or you can also use its command, C.
In order for students to draw an circle, they can use
the Pull-Down Menu, Icon or Command Line. There
are 6 methods to draw an circle from the Pull-Down
Menu.

Line Polyline ™ Circle Arc

L
| =" ] Center, Radius

DRAWING REC | =" | Center, Diameter

() 2-Point

Details

File name: 16DEl /~ ™ 1-Point

|_: - Tan, lan, Radius

1" lan, Tan, lan

Figure 2.15 : Circle




a. Center, Radius and Center, Diameter

I. Center and Radius

Creates a circle based on a center point and a radius or diameter
Center Point  value. (1)

Radius Enter a value, or specify a point. (2)

Figure 2.16 : Center and Radius

li. Center and Diameter

Creates a circle based on a center point and a radius or diameter
Center Point  Vvalue. (1)

\ >\ Diameter  Enter a value, or specify a second point. (2)

Figure 2.17 : Center and Diameter

iii. 2P (Two Points)

Creates a circle based on two endpoints
of the diameter.

With the 2 Point (2P) method, you can click or enter two points
that will establish a diameter for the circle. you can specify
various combinations of center, radius, diameter, points on the
circumference, and points on other objects.

To draw the circle that sits at the top of the left rectangle, you'll
need to specify the two diameter points so that the diameter of
the circle matches the upper edge of the rectangle. Align the
cursor with the top-left corner so that you see a green square
appear, then click to specify the first point

Figure 2.18 : Circle Two Point




iv. 3P (Three Points)

With the 2 Point (3P) method, click or enter three points to
create a circle that will touch all three points. we need to specify
the first point as (1). we need to specify the third point like the
second point by entering a length value and angle value (2). Or
directly specifying the third point as (3)

To draw the circle that sits at the top of the left rectangle, you'll
need to specify the two diameter points 50 that the diameter of

the circle matches the upper edge of the rectangle. Align the
cursor with the top-left corner so that you see a green square

appear, then click to specify the first point

Figure 2.19 : Circle Three Point

v. Tan, Tan, Radius

2 circles or 2 lines are sufficient for this type of circle. select 2
point on 2 tangents of a line or circle it will specify the perimeter

of a circle and then give the radius of the circle

It means this type of circle can be draw by Tangent, Tangent
and Radius

Figure 2.20: Tan, Tan, Radius

vi. Tan, Tan, Tan
Creates a circle tangent to three objects.

Tangent
=) 1

3.00

Figure 2.21: Tan, Tan, Tan




To create circles, you can specify various
combinations of center, radius, diameter, points on
the circumference, and points on other objects. The
default method is to specify the center and the

radius. Three other ways to draw a circle are shown
below.

Figure 2.22 : Three Ways Draw Circle

2.1.4 Ellipse

An ellipse is defined as a curve that surrounds two
focal points. The shape of an ellipse is determined by
two axes determined by length and width. We can
also create an ellipse by defining two points on one
axis and an end point on the other axis.

File  Edit View se Format  Tool

- + Move

f_ i rj '.I,'

= Asais, End

= "Elhptical Arc

Figure 2.23 : Ellipse




Creates an ellipse or an elliptical arc.

The first two points of the ellipse determine the
location and length of the first axis. The third point
determines the distance between the center of the
ellipse and the end point of the second axis.

I. Center

Center method, the first axis is determined by the
center point and endpoint, while the second axis is
determined by the length. We can either determine
the point or distance value to create such ellipse.

Figure 2.24 : Center




TOTURIAL 2.1: CENTER

Toturial 1 : Center

| 1. Click on the Ellipse icon on the robbon panal and choose Center from the pull down of \
|' the Ellipse — choose <Center> I|

2. Specify the center of the Ellipse on the viewport

3. Specify endpoint of the first axis, as shown in the below

Center point

l Endpoint of first
s — —_F_nxiﬂ

4. Press Enter. Specify the endpoint or distance value of the second axis.

5. Press Enter. The Ellipse will be created,as shoe below Vertical and herazotal

Caenter point

{ == Endpaoint of first Center point
axis

Distance value =3

%
#

Endpoint of
second axis
Distance value =4

i )
Endpoint of Endpoint of first
second axis aAxis




li. Axis, End

The Ellipse is formed by defining the three points
similar to above. The location and length of the first
axis is specified by the points 1 and 2, while the
distance between the center and the endpoint of
the second axis is specified by the point 3.

1 o 3

Figure 2.25 : Axis, End

iii. Elliptical Arc

The Elliptical Arc command is used to create an

elliptical arc.
1

e
N

5 X
Figure 2.26 : Elliptical Arc

The location and length of the first axis is specified
by the points 1 and 2, while the distance between
the center and the endpoint of the second axis is
specified by the point 3.

The fourth and fifth specified points are the start
and end angles.




TOTURIAL 2.2: ELLIPTICAL ARC

Toturial 2 : Elliptical Arc

1. Click on the Ellipse icom on the ribbon panel and chocse Elliptical Arc from the pull

doen list, as shown in tha below:

r—-

o --__'_'].. Cernter

{‘_-_ ____'_:I- Aois, Emd

{ = *Elhptical frc

2. Specify the endpoint or the center of the elliptical arc.

3. Specify endpoint of the axis, as below :

ol B, B65F =« O°

4. Specify endpoint of other axis, as below :

'
= [

19 | Page



Example ellipse show two different ellipses created
by specifying axis and distance. The third point
specifies only a distance and does not necessarily
designate the axis endpoint.

first axes 08 Mapor axis fursd @MiS A5 Minod

SRS
Figure 2.27 : Different Ellipse

2.1.5 Polygon

Polygons are closed geometries made with three or
more sides. The smallest polygon is a triangle and
the largest polygon is a circle, which is made up of an
infinite number of sides. In AutoCAD, you can make
a polygon with a minimum of 3 and a maximum of

1,024 sides.

Figure 2.28 : Polygon

Polygon is basically divided into 2:

i. Incribed in circle

A polygon is a shape drawn inside a circle. The order
used in making a polygon with vertices or angles
touching a circle is Inscribed in circle or shortcut
command for inscribing is |




Figure 2.29 : Incribed in circle

e Specifies the radius of a circle on which all
vertices of the polygon lie.

o Specifying the radius with your pointing device
determines the rotation and size of the polygon.

e Specifying the radius with a value draws the

bottom edge of the polygon at the current snap
rotation angle.

ii. Circumscribed about circle

Use circumscribed polygon when you want to
specify the distance between the center of the
polygon and midpoint of each side.

AR 4.0

Figure 2.30 : Circumscribed about circle
o Specifies the distance from the center to the
midpoints of the edges of the polygon.
e Specifying the radius with your pointing device
determines the rotation and size of the polygon.
e Specifying the radius with a value draws the

bottom edge of the polygon at the current snap
rotation angle.




2.1.6 Polyline

Creates a 2D polyline, a single object that is
composed of line and arc segments.

Drawing Polyline is more complex than drawing
Line. A single Polyline can be composed of a number
of a straight line or arc-segment. Polyline can also be
given line widths to make them appear solid.

i -
= 4
. <q
= -4
o =
e =

Figure 2.31 : Polyline
Specify start point Specify next point

Al.'nnu:l-n-mn.' plus-shaped marker displays at the first

If you enter a (for Arc), you create arc segments

Table 2.1 : Specify start point

2.1.7 Donut

This command draws a solid donut shape. Drawing
doughnut is a quick way to create filled-rings or solid
filled-circles. Creates afilled circle or a wide ring.

Figure 2.32 : Donut




Donut consists of two arc polylines that are joined
end-to-end to create a circular shape. The width of
the polylines is determined by the specified inside
and outside diameters. If you specify an inside
diameter of O, the donut is a filled circle.

a— ) Pensldede
Diamyeter Lspecifies the inside diameter of the donut as shown.
Crutnicle specifies the outside diameter of the donut
l:li.ﬂl-bl:llll I h

O wlneter Center of Specifies the location of the donut based on its CcEnter
0 & Point. A donut 15 draven at each point specified wmntil

you prez: Enter to end the command,

Figure 2.33 : Diameter Donut

2.2 Drawing Aids

2.2.1 Snap

Snap mode restricts the movement of the crosshair
to intervals that are defined. When snap mode is on,
the cursor seems to adhere or snap, to an invisible
rectangular grid. Snap is useful for specifying precise
points with the arrow keys or the pointing device.
Restricts cursor movement to specified intervals.
The following prompts are displayed.

Snap Spacing - Activates Snap mode with the value
you specify.

On - Activates Snap mode using the current settings
of the snap grid.

Figure 2.34 : Snap

Off - Turns off Snap mode but retains the current
settings




[ T T EER ]

Figure 2.36 : Example of OSNAP in Drawing

2.2.2 Properties Palette

The properties palette is an essential tool. For
properties palette can open with the PROPERTIES
command ( enter PR in the Command window ) or

il

L8
W M TR

i T AT

ik PRI R

Y TTe S e

1o MW

o PRLOF (PR TR LR

Figure 2.37 : Palette




Figure 2.38 : Properties Palette

The properties palette display a list of all important
property setting like

e Color

o [ayer

2.3 Edit Commands

AutoCAD drawings are rarely completed simply by
drawing lines, circles etc. Most likely you will need to
Modify these basic drawing objects in some way in
order to create the image you need. AutoCAD
provides a whole range of modify tools such as
Move, Copy, Rotate and Mirror. As you can see, the
command names are easily understandable. Perform
editing operations such as erase, move, and trim on
the objects in a drawing.




The most common of these tools are located on the
Modify panel of the Home tab.

Figure 2.39 : Edit Commands

2.3.1 TheErase

The erase command is used to remove or delete
objects from the drawing, as shown in the below
Image.

Figure 2.40: Erase

No 1 and 2 are the numbers of the selected objects.
The selected objects can also be removed with the
help of the 'Delete’ button on the keyboard




2.3.2 The Move and Copy Command m

The move command in AutoCAD is used to move
objects at a predetermined distance and direction.
There are 4 steps to move an object at a certain
distance in a specified direction. We can use Move
Command from the Modify panel or use command
M in command line.

Select objects
Select the objects.

Specily the base point
— Specify the starting point to move, which acts as a base point
of an object.

Specily the point to place a moving obpect

Specify a point to put the object being moved. We can either spacity
it using a cursor or can enter the displacement value n the X, ¥, and
Z-direction. For example, 3, 4. The object will be moved 3 Units in
thee X-direction and 4 Unit= in the Y-direction from its current
position,

Displacement

It signifies the relative distance and direction of the object from
its last position. It determines how far the object is placed from
its original position

Figure 2.41 : Move and Copy Command

The copy command is used to copy the objects.

Figure 2.42 : Copy Object




2.3.3 Rotate m

The rotate command changes the orientation of
existing entities by rotating them about a specified
base point. The rotation angle may be given as a
numeric value or by dragging the entity.

Figure 2.43 : Rotate

2.3.4 Break -

Allow partial erasure of line, arc, circle, 2D, 3D

polylines and ellipse. Circle and arc are broken in a
counter clockwise direction.

Figure 2.44 : Break




2.3.5 Trim BN

The Trim command in AutoCAD is used to remove
objects/lines which is not desired in another object
meets the edge of another object. It is also used to
remove extra lines or extra parts of objects. We can
also do the trim using different selection ethods.

Figure 2.45 : Trim

2.3.6 Scale m

The Scale command is used to increase or decrease
the size of an object by a specified factor. If we
specify a value of O to 1, the size of the object will be
reduced according to that factor. If we want to
Increase the size of an object, we need to specify its
value greater than 1.

Figure 2.46 : Scale

2.3.7 Mirror m

The mirror command in AutoCAD is used to make a
copy (mirror copy) of the selected object. we can




also discard the actual cbjek after copying the
original object. An object copied by a mirror equal to
half of its object can be mirrored across the center
line to create the other half of the object.

It is shown in the picture below:
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Figure 2.47 : Mirror

Note: By default, when you mirror a text object, the
direction of the text is not changed. Set the
MIRRTEXT system variable to 1 if you do want the
text to be reversed.

2.3.8 Array

The array command creates either a Rectangular or
Polar (circular) pattern existing object that you
select. The pattern could be created from a single or
a group of objects. Array duplicate set of objects for
each item in the array. There are three types of
arrays, which are listed below




e Rectangular Array - Distributes object copies into
any combination of rows, columns and levels.

Rectangular Array —
» The rectangular arrangement * - :

order is used to propagate coples
of selected objects into

combinations in the form of rows,
columns, and levels,

» The arrangement of the copied
objects is in the form of a

rectangle. Rows and columns are E x x> >

filled with the same number of
items in 8 given row or column.,

Figure 2.48 : Rectangular Array

e Polar Array - Evenly distributes object copies in
a circular pattern around a center point or axis
rotition

Figure 2.49 : Polar Array

e Path Array - distributes the copies of the object
along its path. We need to select the
corresponding path to distribute the array.
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Figure 2.50 : Path Array




2.3.9 Fillet and Chamfer

The fillet command is used to create rounded edges
between the adjacent lines and faces in 2D and 3D.
It is also used to connect two tangent arcs in 2D.
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Figure 2.51 : Fillet and Chamfer

ii. Chamfer |

The chamfer command in AutoCAD is used to create

slanted edges.We are required to select the two
adjacent lines to create chamfer between them

Example 1 Example 3

Second line

Figure 2.52 : Chamfer




2.3.10 Offset =

The offset command in AutoCAD is used to create
parallel lines, concentric circles, and parallel curves.
It can offset any object through a point or at a
specified distance. We can create as many parallel
lines and curves with the help of the offset
command. The offset objects can also be modified
further according to the requirements. Here,
modification of offset object means that we can
apply trim, extend, and other methods on it.
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Figure 2.53 : Offset




2.3.11 Polyline Edit (P edit) -

You can choose from several useful options when
you want to modify a polyline. The PEDIT command
(enter PE in the Command window) is located on the
drop-down list of the Modify panel. With this
command, you can

@ Width (constant or varying)

@ Consist of arcs and lines.

@ Edited and joined together.
DExploded into individual segments

Command Keystroke Ilcon Location Result
Polyline Pline / PL Home > Draw Creates a polyline of
= Polyline arcs and/or lines.
Polyline Pedit / PE =5 Home >Modify  Edits polyline

Edit > Polyline Edit objeclts







CHAPTER 3
MEASURE AND DIMENSION

3.1 MEASURE

I. Measures the distance, radius, angle, area, and
volume of selected objects or sequence of points.
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Measure

Figure 3.1 : Measure Icon

Ii. The MEASURE command performs many of the
same calculations as the following commands:

a. Distance <

NE
b. Area | 3
c. Radius ]
d. Angle

eauay Distance

.‘l_
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Figure 3.2 : Measure




3.1.1 Distance

Measures the distance between specified points
along with the X, Y, and Z component distances and
the angle relative to the UCS.

|""| Distance

Figure 3.3 : Distance

o Multiple points - Displays a running total of
the distance between successive points. If
you enter the Arc, Length, or Undo options,
additional options similar to those for
creating a polyline are displayed.

3.1.2 Area

Measures the area and perimeter of an object or
defined area.

Figure 3.4 : Area

Specify corner points. Calculates the area and
perimeter defined by specified points.

If you enter the Arc, Length, or Undo options,
additional options similar to those for creating a
polyline are displayed.




e Add area-Turns on Add mode and keeps a
running total of area as you define areas.

e Subtract area - Subtracts a specified area from
the total area.

3.1.3 Diameter and Radius

Measures the radius and diameter of a specified
arc, circle, or polyline arc.

-.‘

: ‘ Radius

Figure 3.5 : Radius

3.1.4 Angle

Measures the angle

Figure 3.6 : Angle




3.2 DIMENSIONING

It is used to display the dimensions of drawings or
models in AutoCAD. We can modify the
dimensions in different drawing units according to

the requirements.
The dimension area on the ribbon panel will look

like the below image:
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Figure 3.7 : Dimension
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Figure 3.8 : Part of Dimension

3.1.4 Example 3

Figure 3.9 : Example




3.2.1 Linear

Linear Dimension scan create horizontal, vertical,
aligned and dadial domensions eith DIM command.
The type of dimension depends on the object that
select and the direction that drag the dimension
line.

Figure 3.10 : Linear

o Select the first point and second point of a line
to be measured

e The dimension of the corresponding line will be
displayed

3.2.2 Aligned ,, Aligned

The aligned dimension will give us the exact
distance between the two selected points or
endpoints. It is commonly used to measure the
slanted lines. The dimensions will be parallel to the
created slanted line.

Figure 3.11 : Aligned




3.2.3 An gu lar \ Angular

¥

Angular dimensions measure the angle between
two selected geometric objects or three points.
From left to right, the example shows angular
dimensions created using a vertex and two points,
an arc, and two lines. Measures the angle between
selected geometric objects or 3 points.

3.2.4 Diameter |::I Diameter

Creates a diameter dimension for a circle or an arc.
Measures the diameter of a selected circle or arc,
and displays the dimension text with a diameter
symbol in front of it. You can use grips to easily
reposition the resulting diameter dimension.

Figure 3.13 : Diameter




3.2.5 Radius Radius

Creates a radius dimension for a circle or an arc.
Measures the radius of a selected circle or arc and
displays the dimension text with a radius symbol in
front of it. You can use grips to reposition the
resulting radius dimension easily.

Figure 3.14 : Radius




TOTURIAL 3.1: AUTOCAD 2D

Step 1
Use the CIRCLE command to create the following circles. They all have the
same center. Have 4 circle have do.




Step 2
< Use the upper quadrant of the biggest circle to cteate .

Step 3
LIse the Polar Array command and to 2 circles to construct the set ufuhje>




Step 2
< Use the upper quadrant of the biggest circle to cteate .

Step 3
LIse the Polar Array command and to 2 circles to construct the set ufuhje>




Step 4
Use tan, tan, radius to create circle between 2 circle.




Step 6
< Select the circlefline in the polar array and trim such to have the image

Step 7
Create these 2 circles and do a polar array of 3 items as show on the imeg>




Step 9




Exercise: AUTOCAD 2D

PROCEDURE
1. By using all commands, draw the figure 2 by using metric unit...
2. Using layer command, create layer object and layer dimension.
3. Insert all dimension .
4. Save your work in your computer with name.. NO MATRIC
.
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PROCEDURE

1. By using all commands, draw the figure 3 by using metnc unit.
2. Using whlock command create each part with the name as legend 1.
3. Save your work in your computer with name .. PRACTICAL WORK 3

Figure 3

TransFormer

MPN Transister

PMP Transister
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